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Allgemeine Einführung: Pro/DESKTOP, ICEM und
CDRS in Pro/ENGINEER importieren
Sie können ein Pro/ENGINEER Modell anhängen, um Pro/DESKTOP Modelle, ICEM Surf und ICEM
DDN Kurven und Flächen oder CDRS Flächenmodelle einzuschließen. Jede Desktop, ICEM oder CDRS
Datei, die Sie dem Pro/ENGINEER Modell anhängen, erzeugt in Pro/ENGINEER jeweils ein KE. Sie
können einem Pro/ENGINEER Modell beliebig viele KEs hinzufügen. Außerdem können Sie auch ein
neues Pro/ENGINEER Modell erzeugen, indem Sie eine Desktop, ICEM oder CDRS Datei importieren.

So erstellen Sie ein Pro/ENGINEER Modell aus
einer Pro/DESKTOP, ICEM oder CDRS Datei
1. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

geöffnet.
2. Klicken Sie in der Liste Typ (Type) auf eine der folgenden Optionen:

� ICEM (.icm)

� Pro/DESKTOP (.pdt)

� CDRS (.neu)

Es werden alle Dateien des ausgewählten Typs aufgelistet, die sich im Arbeitsverzeichnis befinden.
3. Wenn die gewünschte Datei nicht im Arbeitsverzeichnis enthalten ist, suchen Sie nach ihr.
4. Klicken Sie auf die Datei mit der Erweiterung .áÅãI=KéÇí=çÇÉê=KåÉì, die Sie in Pro/ENGINEER

importieren möchten.
5. Klicken Sie auf OK. Die Datei wird importiert, und im Pro/ENGINEER Fenster erscheint eine

Meldung, daß das KE erfolgreich erstellt wurde.
6. Wiederholen Sie die Schritte 1 bis 5 für alle KEs, die aus Pro/DESKTOP, ICEM oder CDRS importiert

werden sollen.

So hängen Sie ein Pro/ENGINEER Modell an eine
Pro/DESKTOP, ICEM oder CDRS Datei an
1. Klicken Sie in einem geöffneten Teil oder in einer geöffneten Baugruppe auf Einfuegen > Daten aus

Datei (Insert > Data From File). Das Dialogfenster Oeffnen (Open) erscheint.
2. Klicken Sie in der Liste Typ (Type) auf eine der folgenden Optionen:

� ICEM (.icm)

� Pro/DESKTOP (.pdt)

� CDRS (.neu)

Es werden alle Dateien des ausgewählten Typs aufgelistet, die sich im Arbeitsverzeichnis befinden.
3. Wenn die gewünschte Datei nicht im Arbeitsverzeichnis enthalten ist, suchen Sie nach ihr.
4. Doppelklicken Sie auf die Datei mit der Erweiterung .áÅãI=KéÇí=çÇÉê=KåÉì, die Sie dem Modell

hinzufügen möchten.
5. Wenn die Pro/ENGINEER-Datei ein oder mehrere Koordinatensysteme enthält, wird das Dialogfenster

Volumenkoerper-Optionen und Plazierung (Choose Solid Options and Placement) geöffnet.
Akzeptieren Sie in diesem Dialogfeld das Standardkoordinatensystem, oder wählen Sie mit den
Auswahlpfeilen ein anderes Koordinatensystem aus.

6. Klicken Sie auf OK. Die Datei wird importiert, und im Pro/ENGINEER Fenster erscheint eine
Meldung, daß das KE erfolgreich erstellt wurde.

7. Wiederholen Sie die Schritte 1 bis 5 für alle KEs, die aus ICEM, Pro/DESKTOP oder CDRS importiert
werden sollen.
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So definieren Sie ein Pro/DESKTOP, ICEM oder
CDRS Modell in Pro/ENGINEER um
Hinweis: Associative Topology Bus unterstützt nicht die Funktionalität zum Umdefinieren von Import-
KEs ("Redefine Import") von Pro/ENGINEER. Sie können zwar mit Associative Topology Bus importierte
Geometrie umdefinieren, die importierte Geometrie wird jedoch möglicherweise nicht-assoziativ.

Nachdem Sie dem Pro/ENGINEER Teil ein Pro/DESKTOP, ICEM oder CDRS KE hinzugefügt haben,
führen Sie die folgenden Schritte aus:

1. Wählen Sie KONSTR-ELEM > Umdefinieren (FEAT > Redefine).
2. Wählen Sie das Pro/DESKTOP, ICEM oder CDRS KE aus, das Sie umdefinieren möchten. Es erscheint

das Menü IMPORT UMDEF (REDEF IMPT).
3. Wählen Sie den Befehl Datei (File). Das Dialogfenster Oeffnen (Open) erscheint.
4. Wählen Sie die .éÇíJI=KáÅãJ=çÇÉê=KåÉìJDatei aus, durch die Sie das ursprüngliche

Pro/DESKTOP, ICEM oder CDRS KE ersetzen möchten. Das Dialogfenster Volumenkoerper-
Optionen und Plazierung (Choose Solid Options and Placement) wird geöffnet.

5. Wählen Sie ein Koordinatensystem. Das Menü DATEI IMP (IMPT FILE) und ein Fenster mit dem zu
ersetzenden KE wird geöffnet.

6. Wählen Sie den Befehl Fertig (Done) im Menü DATEI IMP (IMPT FILE).
7. Wählen Sie den Befehl Fertig (Done) im Menü IMPORT UMDEF (REDEF IMPT). Im

Pro/ENGINEER Fenster wird eine Meldung angezeigt. Beispiel:
P=pí~åÇ~êÇJm~~êÉ=ÖÉÑìåÇÉå=ìåÇ=ÜÉêîçêÖÉÜçÄÉåK=pí~åÇ~êÇJm~~êÉ

~âòÉéíáÉêÉå\==g~===kÉáå

8. Mit Ja (Yes) übernehmen Sie die Standardpaare. Das Menü PAARIMPORT (IMPORT PAIRS) wird
geöffnet.

9. Wählen Sie anschließend den Befehl Fertig (Done).

So aktualisieren Sie automatisch ein
Pro/DESKTOP, ICEM oder CDRS Modell in
Pro/ENGINEER
1. Importieren Sie ein Pro/DESKTOP, ICEM oder CDRS KE in Pro/ENGINEER, oder fügen Sie dem

Pro/ENGINEER Modell ein Pro/DESKTOP, ICEM oder CDRS KE hinzu.
2. Erzeugen Sie gegebenenfalls zusätzliche Geometrie.
3. Speichern Sie die Kéêí-Datei.
4. Entfernen Sie die .éêí-Datei aus dem Speicher. Wählen Sie hierzu die Befehlsfolge Datei >

Wegnehmen > Aktuell (File > Erase > Current), oder beenden Sie Pro/ENGINEER.
5. Wenn Sie mit dem Modell arbeiten möchten, öffnen Sie die Kéêí-Datei, die Sie mit den Schritten 1 – 3

erzeugt haben. Wenn sich die ursprüngliche .éÇíJ=EmêçLabphqlmFIKáÅãJ=Ef`bjF=çÇÉê
KåÉì-Datei E`aopF=in Ihrem Arbeitsverzeichnis geändert hat, erscheint die folgende Meldung:
abphqlm=Ef`bj=çÇÉê=`aopF=hb=áëí=îÉê~äíÉíX=ãáí=DoÉÖÉåÉêáÉêÉåD

~âíì~äáëáÉêÉåK=Eabphqlm=Ef`bj=çÇÉê=`aopF=ÑÉ~íìêÉ=áë=çìí=çÑ=Ç~íÉX=Üáí

oÉÖÉåÉê~íÉ=íç=ìéÇ~íÉK

6. Mit Regenerieren (Regenerate) können Sie das KE im Modell aktualisieren. Die folgende Meldung
wird angezeigt, und das Menü Bestaetigung (Confirmation) wird geöffnet:
abphqlm=Ef`bj=çÇÉê=`aopF=a~íÉå=ëáåÇ=îÉê~äíÉíX=ÖÉÖÉåï~ÉêíáÖÉ=a~íÉå

~âíì~äáëáÉêÉå\=abphqlm=Ef`bj=çê=`aopF=Ç~í~=áë=çìí=çÑ=Ç~íÉX=Çç=óçì

ï~åí=íç=ìéÇ~íÉ=íç=íÜÉ=ÅìêêÉåí=Ç~í~\

jáí=_Éëí~ÉíáÖÉå=E`çåÑáêãF=ÑΩÜêÉå=páÉ=ÇáÉ=^âíì~äáëáÉêìåÖ=ÇìêÅÜX=ãáí

^ÄÄêÉÅÜÉå=E`~åÅÉäF=ïáêÇ=Ç~ë=jÉåΩ=_bpq^bqfdrkd=E`lkcfoj^qflkF

ÖÉëÅÜäçëëÉåK
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� Beim Aktualisieren der Daten wird auch die gesamte Geometrie im Modell aktualisiert, mit der die
Geometrie des Pro/DESKTOP, ICEM oder CDRS KEs referenziert wird. Die Aktualisierung ist
assoziativ.

� Wenn Sie Abbrechen (Cancel) wählen, werden Sie beim nächsten Klicken auf Regenerieren
(Regenerate) aufgefordert, die Pro/DESKTOP, ICEM bzw. CDRS Daten zu aktualisieren.

Menü FLAECHENINFO (SURF INFO)
Bei der Arbeit mit Flächen, die aus CDRS importiert wurden, enthält das Menü FLAECHENINFO (SURF
INFO) zusätzliche Befehle. Im Menü Flaech vergleich (Compare Srfs) wird die Abweichung jeder
importierten Fläche relativ zu ihrem Gegenstück angezeigt. Wenn Sie auf Flaech vergleich (Compare
Srfs) klicken, wird das Menü FLAECH VERGL (COMPARE SRFS) mit folgenden Befehlen aufgerufen:

� Einzeln (One by One) — Wählt eine einzelne Teilfläche aus, um ihre Abweichung von ihrem
Gegenstück anzuzeigen.

� Sammelflaeche (Select Quilt) — Zeigt die Abweichung einer ausgewählten Sammelfläche von ihrem
Gegenstück.

� Alle ausw (Select All) — Zeigt die Abweichung aller Teilflächen an.

Allgemeine Einführung: In der Associative
Topology Bus Umgebung arbeiten
Associative Topology Bus (ATB) schafft die Umgebung für die Arbeit mit einer heterogenen Baugruppe.
Eine heterogene Baugruppe enthält Modelle, die ursprünglich in verschiedenen CAD-Systemen, z.B.
Pro/ENGINEER und CADDS 5, erzeugt wurden. Mit Associative Topology Bus können mehrere Systeme
Geometrie, Topologie und Baugruppenstruktur auf assoziative Weise gemeinsam nutzen, ohne daß die
ursprüngliche Applikation auf dem jeweiligen Desktop-System geladen sein muß.

Bei der Verwendung von Associative Topology Bus werden Änderungen, die an Daten im Ausgangssystem
vorgenommen wurden, an die gesamte heterogene Umgebung weitergegeben. Wenn ein Teil oder eine
Baugruppe aus einer Associative Topology Bus-fähigen Applikation in Pro/ENGINEER importiert wird,
wird in Pro/ENGINEER ein TIM (Translated Image Model) von dem Teil erstellt. Ein TIM gleicht einem
Pro/ENGINEER Modell mit dem Unterschied, daß es eine Kennzeichnung enthält, die auf den Ursprung
des Modells hinweist.

Beim Datenaustausch mit Associative Topology Bus bleiben eindeutige IDs erhalten, und die aktuelle
Modellversionsnummer wird erkannt. Beachten Sie die folgenden Empfehlungen und Einschränkungen:

� Mit Associative Topology Bus können Sie importierte Geometrie referenzieren. Modelle, die in
Pro/ENGINEER importiert wurden, sollten jedoch nicht geändert werden. Alle Änderungen an
Objekten sollten in dem System vorgenommen werden, aus dem sie importiert wurden.

� Associative Topology Bus unterstützt nicht die Funktionalität zum Umdefinieren von Import-KEs
("Redefine Import") von Pro/ENGINEER. Sie können zwar mit Associative Topology Bus importierte
Geometrie umdefinieren, die importierte Geometrie wird jedoch möglicherweise nicht-assoziativ.

Hinweise zu Associative Topology Bus

� Wenn Sie in der Pro/ENGINEER Umgebung Änderungen am Baugruppenbaum einer TIM Baugruppe
(Translated Image Model) vorgenommen haben, können einige Ihrer Änderungen während der
Baugruppenaktualisierung verlorengehen.

� Pro/ENGINEER betrachtet importierte Teile und Baugruppen – einschließlich all ihrer Modelle – als
Eigentum von und assoziativ mit den referenzierten Teilen und Baugruppen.

� Jede(s) aus CADDS 5 und CATIA importierte Teil oder Baugruppe wird im Pro/ENGINEER
Modellbaum mit einem Symbol aufgelistet. Dieses Symbol zeigt an, daß die Komponente aus CADDS
5 oder CATIA importiert wurde und mit dem ursprünglichen Modell assoziativ ist.
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Hinweis: Associative Topology Bus CADDS 5 ist in zwei Richtungen verwendbar. Sie können mit einem
CADDS 5 Teil in Pro/ENGINEER und mit einem Pro/ENGINEER Teil in CADDS 5 arbeiten. Weitere
Informationen zu CADDS 5 Associative Topology Bus finden Sie in der CADDS 5 Dokumentation im
Abschnitt zur Verwendung des Associative Topology Bus-fähigen CADDS 5I .

Allgemeine Einführung: Fähigkeiten von
Associative Topology Bus auf Teileebene
Als Pro/ENGINEER Benutzer, der ein Teil in ein Pro/ENGINEER Translated Image Model (TIM) dieses
Teils umgewandelt hat, haben Sie folgende Möglichkeiten:

� Das Teil unverändert verwenden

� Downstream-Applikationen wie Pro/MECHANICA oder Pro/MANUFACTURING auf das Teil
anwenden

� Über die Benutzeroberfläche überprüfen, ob das Teil veraltet ist

� Über die Benutzeroberfläche eine Aktualisierung anfordern

� Das Teil mit den Änderungen, die am ursprünglichen Teil vorgenommen wurden, aktualisieren. Die
Assoziativität zwischen der importierten Geometrie und der Geometrie und den Applikationsdaten, die
in der Pro/ENGINEER Umgebung hinzugefügt wurden, bleibt erhalten.

Allgemeine Einführung: Fähigkeiten von
Associative Topology Bus auf Baugruppenebene
Als Pro/ENGINEER Benutzer, der eine Baugruppe in ein Pro/ENGINEER TIM (Baugruppe) umgewandelt
hat, haben Sie folgende Möglichkeiten:

� Sich die Baugruppe unverändert ansehen

� Die Baugruppe referenzieren

� Zum Zeitpunkt der Baugruppenaktivierung automatisch überprüfen, ob die importierte Baugruppe oder
einer ihrer Knoten veraltet ist

� Manuell über die Benutzeroberfläche überprüfen, ob die importierte Baugruppe oder einer ihrer Knoten
veraltet ist

� Die Baugruppe mit den Änderungen, die an der ursprünglichen Baugruppe vorgenommen wurden,
aktualisieren. Die Aktualisierung erfolgt inkrementell, und nur die Knoten, die verändert werden
müssen, werden aktualisiert

� Bei Associative Topology Bus werden gegebenenfalls Komponenten im Baugruppenbaum verschoben,
zum Baum hinzugefügt oder aus diesem gelöscht.

Allgemeine Einführung: Associative Topology
Bus CADDS 5 und Pro/CABLING
Weitere Informationen über CADDS 5 Associative Topology Bus finden Sie in der CADDS 5
Dokumentation im Abschnitt zur Verwendung des Associative Topology Bus-fähigen CADDS 5i.

Associative Topology Bus überträgt Verkabelungsdaten als Geometrie (Mittellinien und Endpunkte) und
Hilfsdaten (Durchmesser, Namen von Drähten, Kablen, Bündeln, Steckern etc.) nach CADDS 5. Beim
Aufrufen von Pro/CABLING-Daten in CADDS 5 werden die Daten in CADDS-Kabel umgewandelt. Es
werden nur dicke Drähte unterstützt.

Pro/ENGINEER Verkabelungsgeometrie, die nach CADDS 5 exportiert wurde, kann in der CADDS 5
Umgebung nicht geändert werden.
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Nach CADDS 5 übertragene Pro/CABLING Daten

Associative Topology Bus exportiert folgende geometrische und Hilfs-Verkabelungsdaten nach CADDS 5:

� Kabelbaumteil mit entsprechender Kennung, die es als Verkabelungsteil ausweist

� Mittellinien-Elemente, die zu den Draht-, Kabel- oder Bündelkomponenten des Kabelbaumteils
gehören

Jedes Mittellinien-Element hat eine ID, einen Durchmesser und einen Namen. Der Name der Mittellinie
entspricht dem Namen des größten Verkabelungselements, in dem diese Mittellinie verwendet wird.
(Beispiel: Die Mittellinie stellt ein Kabel mit der Bezeichnung h~ÄÉäN dar, das vier Leiter mit den
Bezeichnungen aê~ÜíN=KKK=aê~ÜíQ enthält. Die Bezeichnung der Mittellinie lautet h~ÄÉäN.)
Jedes zu einem Kabel gehörige Mittellinien-Element wird mit einem Durchmesser versehen, da sich der
Durchmesser von Kabeln an einem Kabelstoß ändern kann.

� Die Verbindungspunkte, die die Kabelenden darstellen Jeder Verbindungspunkt ist mit seiner ID und
dem Namen des Steckerteils in der Baugruppe, zu der das Kabel verlegt ist, versehen.

Darstellung von Pro/CABLING Daten in CADDS 5

Pro/CABLING Daten werden in einer CADDS 5 Baugruppe folgendermaßen verarbeitet:

� Associative Topology Bus erzeugt ein Bauteil pro Kabelbaumteil über CV-DORS. Das Teil enthält nur
Nsplines, die die Kabelsegmente darstellen.

� An den Enden des Nspline werden Spezialelemente erzeugt, die den Anschlußpunkt des Kanals zum
Stecker kennzeichnen (als CAMU Knoten). Jedes Anschlußpunkt-Element ist mit dem Namen des
dazugehörigen Steckers gekennzeichnet (`ljmk^jb:=YòÉáÅÜÉåâÉííÉåíóé[F.

� Jeder Nspline hat folgende Attribute:

Name des Kanals oder Kabels (COMPNAME : YòÉáÅÜÉåâÉííÉåíóé[F
Durchmesser in Modelleinheiten (PLIST : YÉÅÜíÉê=íóé[FK

Allgemeine Einführung: Teile und Baugruppen mit
Associative Topology Bus in CADDS 5
exportieren
Weitere Informationen über CADDS 5 Associative Topology Bus finden Sie in der CADDS 5
Dokumentation im Abschnitt zur Verwendung des Associative Topology Bus-fähigen CADDS 5i.

Associative Topology Bus CADDS 5 bietet sowohl CADDS 5- als auch Pro/ENGINEER Benutzern eine
heterogene Umgebung. CADDS 5 Teile und Pro/ENGINEER Teile und Baugruppen können für Modell-
und Baugruppenarbeiten in einer CADDS 5 oder Pro/ENGINEER Umgebung verwendet werden.
Pro/ENGINEER Benutzer können CADDS 5 Teile importieren und aktualisieren. CADDS 5 Benutzer
können nach dem Import überprüfen, ob das importierte Pro/ENGINEER Teil aktuell ist. Associative
Topology Bus exportiert Daten folgendermaßen in CADDS 5:

� Exportiert werden nur Teile und Baugruppen, die Pro/ENGINEER gehören. Dies gilt für die folgenden
Punkte:

� Baugruppe der obersten Ebene aus Pro/ENGINEER

� Teile- und Unterbaugruppen-Komponenten in der Baugruppe der obersten Ebene aus
Pro/ENGINEER

� Importierte CADDS 5-Modelle, die in Pro/ENGINEER bearbeitet wurden

Hinweis: Wenn Sie das bearbeitete CADDS 5-Modell wieder nach CADDS 5 exportieren, wird
damit das ursprüngliche CADDS 5-Modell überschrieben.

� Importierte CADDS 5 Komponenten der Baugruppe der obersten Ebene werden nicht nach CADDS 5
exportiert; die exportierte Baugruppe der obersten Ebene verwendet vielmehr die tatsächlichen CADDS
5 Teile und Baugruppen, die von den importierten Objekten der Pro/ENGINEER Baugruppe der
obersten Ebene referenziert werden.
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 Allgemeine Einführung: CADDS 5 und CATIA
Modelle in Pro/ENGINEER importieren
Associative Topology Bus unterstützt das Importieren von Teilen und Baugruppen. Für importierte Objekte
gelten die folgenden Regeln:

� Pro/ENGINEER betrachtet importierte Teile und Baugruppen – einschließlich all ihrer Komponenten –
als Eigentum von und assoziativ mit den referenzierten Teilen und Baugruppen und als Eigentum des
referenzierten Systems.

� Damit CADDS 5 die Zuordnung zwischen dem extern referenzierten Modell und den importierten
Komponenten unterstützen kann, muß sich das referenzierte CADDS 5 Modell in einem Verzeichnis
befinden, das in der Umgebungsvariable CVPATH definiert ist.

� Damit CATIA die Zuordnung zwischen dem extern referenzierten Modell und den importierten
Komponenten unterstützen kann, muß sich das referenzierte CATIA Modell in dem Verzeichnis
befinden, das als Pro/ENGINEER Suchpfad festgelegt wurde.

Jede(s) importierte Teil oder Baugruppe wird im Pro/ENGINEER Modellbaum mit einem Symbol
aufgelistet. Dieses Symbol weist auf die ursprüngliche Quelle der Komponente und deren Zuordnung zum
ursprünglichen Modell hin.

Hinweis: Weitere Informationen zum Exportieren von Pro/ENGINEER in CADDS 5 oder CATIA finden
Sie in der Pro/ENGINEER Hilfe für Interface.

So arbeiten Sie mit Associative Topology Bus
CADDS 5 und CATIA
Bei einer typischen Sitzung fallen die nachstehend aufgeführten Schritte an. Klicken Sie anschließend auf
Siehe auch, um weitere Informationen abzurufen.

1. Vor dem Arbeiten in der Associative Topology Bus (ATB) Umgebung ist folgendes zu
berücksichtigen:

� Setzen Sie die Konfigurationsoption topobus_enable auf yes.

� Wenn Sie mit ATB CADDS 5 arbeiten, setzen Sie die Umgebungsvariable CVPATH.

� Wenn Sie mit ATB CATIA arbeiten, setzen Sie das Standard-Suchpfadverzeichnis von
Pro/ENGINEER auf CATIA.

2. Importieren Sie ein CADDS 5 oder CATIA Modell in Pro/ENGINEER.

3. Erzeugen Sie Pro/ENGINEER Geometrie, indem Sie CADDS 5 oder CATIA Komponenten
referenzieren, und speichern Sie die Baugruppe.

4. Wenn Sie zu der Baugruppe zurückkehren müssen, um weitere Änderungen vorzunehmen, rufen Sie
die Baugruppe auf.

5. Überprüfen Sie, ob eine der importierten Komponenten veraltet ist (manuell oder automatisch).

6. Aktualisieren Sie die veralteten Komponenten.

Hinweis: So wird die Zuordnung zwischen dem extern referenzierten Modell und importierten
Komponenten unterstützt:

� Das referenzierte CADDS 5 Modell muß sich in dem Verzeichnis befinden, das in der
Umgebungsvariable CVPATH definiert ist.

� Das referenzierte CATIA Modell muß sich in dem Verzeichnis befinden, das als Pro/ENGINEER
Suchpfad festgelegt wurde.
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So importieren Sie aus CATIA mit aktiviertem
Associative Topology Bus
Bei der direkten Übertragung von CATIA II ist keine CATIA Lizenz erforderlich. Dies ist die einzige
Übertragungsmethode, die für Associative Topology Bus (ATB) CATIA unterstützt wird. Ist ATB
aktiviert, müssen Sie Pro/ENGINEER und CATIA nicht auf derselben Workstation ausführen, um ein
CATIA Modell direkt zu importieren. Weitere Informationen zum Importieren von und Exportieren in
CATIA finden Sie in der Hilfe zu Interface im Abschnitt über das Importieren aus und Exportieren in
CATIA.

1. Setzen Sie die Konfigurationsoption íçéçÄìë|Éå~ÄäÉ auf óÉë.
2. Setzen Sie die Konfigurationsoption ëÉ~êÅÜ|é~íÜ auf das Pro/ENGINEER Verzeichnis, in dem

nach CATIA Dateien gesucht wird.
3. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

geöffnet.
4. Klicken Sie in der Liste Typ (Type) auf CATIA Direkt (CATIA Direct). Alle CATIA Dateien

(KãçÇÉä) werden im Arbeitsverzeichnis aufgelistet. Wenn die gewünschte Datei nicht im
Arbeitsverzeichnis enthalten ist, suchen Sie nach ihr.

5. Doppelklicken Sie auf den Namen des CATIA Teils oder der Baugruppe, das bzw. die importiert
werden soll. Es erscheint das Dialogfenster Neues Modell importieren (Import New Model). Die
Option Teil (Part) bzw. Baugruppe (Assembly) ist automatisch ausgewählt und zeigt den
Elemententyp an, den Sie importieren möchten.

6. Geben Sie in das Feld Name einen Namen für das importierte Teil bzw. die Baugruppe ein, oder
übernehmen Sie den Standardnamen.

7. Klicken Sie auf OK. Das CATIA Modell wird importiert.

Tip: Konfigurationsoption Catia_Translator
Wenn Sie eine aktive und lizenzierte Benutzeroberfläche für CATIA II mit Associative Topology Bus
haben, die Konfigurationsoption íçéçÄìë|Éå~ÄäÉ jedoch auf åç gesetzt ist, legen Sie mit der
Konfigurationsoption=Å~íá~|íê~åëä~íçê die Methode der direkten CATIA Übertragung fest. Wenn
Sie keine Software-Lizenz für CATIA besitzen, setzen Sie catia_translator auf Å~í|áá
(Standardeinstellung). Dies ist die einzig mögliche Methode der direkten CATIA Übertragung. Wenn Sie
eine Software-Lizenz für CATIA besitzen und diese Lizenz zum Durchführen einer direkten Übertragung
verwenden möchten, setzen Sie=Å~íá~|íê~åëä~íçê auf éêç|Å~íK

So importieren Sie aus CADDS 5 mit aktiviertem
Associative Topology Bus
Weitere Informationen zum Importieren aus und Exportieren in CADDS 5 finden Sie in der Hilfe zu
Interface im Abschnitt über die Verwendung von CADDS 5.

1. Setzen Sie die Konfigurationsoption íçéçÄìë|Éå~ÄäÉ auf óÉë.
2. Legen Sie die Umgebungsvariable CVPATH fest.
3. Um den Import von CADDS 5 Folien zu ermöglichen, setzen Sie die Konfigurationsoption

Å~ÇÇë|áãéçêí|ä~óÉê auf óÉë. Die Voreinstellung ist óÉë.
4. Klicken Sie auf Datei > Oeffnen (File > Open). Das Dialogfenster Datei oeffnen (File Open) wird

aufgerufen.
5. Klicken Sie in der Liste Typ (Type) auf CADDS5. Der Browser wechselt zu einem der Pfade aus der

Umgebungsvariable CVPATH. Dieser Pfad wird im Feld Suchen in (Look in) aufgeführt.
6. Mit dem Pfeil neben Suchen in (Look in) können Sie eine Liste der Pfade anzeigen, die in der

Umgebungsvariable CVPATH definiert sind. Die Pfade beginnen jeweils mit CADDS 5 und sind in
Klammern eingeschlossen.

7. Klicken Sie auf den Pfad, aus dem ein Teil oder eine Baugruppe importiert werden soll.
8. Doppelklicken Sie auf den Namen des zu importierenden Teils oder der Baugruppe aus CADDS 5 an.
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Das Dialogfenster Neues Modell importieren (Import New Model) erscheint. Die Option Teil (Part)
bzw. Baugruppe (Assembly) ist automatisch ausgewählt und zeigt den Elemententyp an, den Sie
importieren möchten.

9. Geben Sie in das Feld Name einen Namen für das importierte Teil bzw. die Baugruppe ein, oder
übernehmen Sie den Standardnamen.

10. Klicken Sie auf OK. Das CADDS 5 Modell wird importiert.

So können Sie Associative Topology Bus
aktivieren und CVPATH setzen
Mit der Umgebungsvariable `sm^qe können Sie die Suchpfade für die Teilekomponenten einer
importierten CADDS 5-Baugruppe festlegen, falls sich diese nicht in demselben Verzeichnis wie die
Baugruppe befinden.

1. Aktivieren Sie Associative Topology Bus. Setzen Sie hierzu die Konfigurationsoption
topobus_enable auf yes. Die Voreinstellung ist åç.

2. Um den Import von CADDS 5 Folien zu ermöglichen, setzen Sie die Konfigurationsoption
Å~ÇÇë|áãéçêí|ä~óÉê auf óÉë. Die Voreinstellung ist yes.

3. Setzen Sie die Umgebungsvariable CVPATH. Beispiel für das Festlegen dieser Variablen:
ëÉíÉåî=`sm^qe=DYéÑ~ÇN[Z`WYéÑ~ÇO[WYéÑ~ÇP[WYéÑ~ÇQ[W=KKKKKYéÑ~Çñ[D

Beim Setzen der Variable CVPATH konnen Sie mehrere Suchpfade angeben.
Pfade sind entweder vollständige oder relative Pfade zu Verzeichnissen auf Festplatten, in denen
CADDS 5 Modelle gespeichert sind. Am Anfang und Ende der Pfadangabe steht ein Apostroph, und
die Pfade sind durch einen Doppelpunkt (:) voneinander getrennt. Im obigen Beispielbestimmt =C
nach dem Eintrag <pfad1> diesen Pfad als Erstellungsverzeichnis. Das Erstellungsverzeichnis ist das
Verzeichnis, in dem die exportierten TIMs (Translated Image Models) aus Pro/ENGINEER beim
Export erstellt werden. Sie können das =C einem beliebigen Verzeichnis im CVPATH zuordnen.

Hinweis: Pro/ENGINEER sucht im aktuellen Arbeitsverzeichnis nach CADDS 5 Komponenten oder
verwendet die Umgebungsvariable `sm^qe als Referenzpunkt für·das Auffinden von Komponenten in
anderen Verzeichnissen. Vergewissern Sie sich, daß die Variable `sm^qe korrekt gesetzt ist, d.h. so, wie
am ursprünglichen Speicherort definiert.

Umgebungsvariable CVPATH
Mit der Umgebungsvariablen CVPATH legen Sie die folgenden Einstellungen fest:

1. Suchpfade, um Komponentenmodelle einer importierten CADDS 5 Baugruppe zu finden, wenn diese
sich nicht in demselben Verzeichnis wie die Baugruppe befinden.

� Suchpfade, um das Referenzteil bzw. die Referenzbaugruppe aus CADDS 5 zu finden, wenn Sie ein
importiertes Translated Image Model (TIM) aus CADDS 5 in Pro/ENGINEER aktualisieren.

� Verzeichnis, in dem alle exportierten CADDS 5 Modelle abgelegt werden.

CVPATH setzen

Beachten Sie folgendes, wenn Sie die Umgebungsvariable CVPATH setzen:

� Wenn die Umgebungsvariable `sm^qe nicht explizit gesetzt ist, verwendet Pro/ENGINEER das
Startverzeichnis von Pro/ENGINEER als Standardeinstellung für `sm^qe und bestimmt es zum
Erstellungsverzeichnis.

� Die Variable `sm^qe muß vor dem Starten einer Pro/ENGINEER Sitzung gesetzt werden. Mit der
Konfigurationsoption ÉñíÉåÇ|Åîé~íÜ können während der Pro/ENGINEER Sitzung Pfade für die
Umgebungsvariable hinzugefügt werden.



Associative Topology Bus 15

� Wenn Sie ein CADDS 5 Baugruppenmodell importieren und das bestehende Teil bzw. die
Unterbaugruppenkomponenten in verschiedenen Verzeichnissen gespeichert sind, müssen Sie jedes
Verzeichnis im Pfad festlegen, damit der Import ausgeführt werden kann. Andernfalls wird eine
Baugruppe mit leeren TIM Teilen erzeugt.

� Um importierte CADDS 5 TIMs in Pro/ENGINEER zu überprüfen und zu aktualisieren, müssen sich
die referenzierten CADDS 5 Modelle in einem der Verzeichnisse befinden, deren Pfade in der
Umgebungsvariable `sm^qe festgelegt wurden.

� Bei der Aktualisierung durchsucht Associative Topology Bus die festgelegten Pfade nacheinander
(zuerst <éÑ~ÇN>, dann <éÑ~ÇO>, dann <éÑ~ÇP> etc). Existieren zwei Versionen des referenzierten
CADDS 5 Modells, z.B. eins in YéÑ~ÇO[ und eins in YéÑ~ÇQ[, verwendet Associative Topology
Bus die in YéÑ~ÇO[ gespeicherte Version als Referenz für die Überprüfung und Aktualisierung. Dies
ist auch dann der Fall, wenn die Version in YéÑ~ÇQ[ eine neuere Version des CADDS 5 Modells ist.

� CVPATH ist dieselbe Umgebungsvariablen-Einstellung, die CADDS 5 verwendet, wenn es Suchpfade
zum Laden von Modellen und für deren Erstellungsverzeichnis festlegt.

Komponenten mit Hilfe des Pfads definieren
In CADDS 5 können Sie Baugruppenkomponenten definieren, indem Sie explizit ihren Pfad in der
Komponente einbauen. Sie können für jeden CADDS 5 Baugruppenkomponenten-Knoten einem Modell
lediglich einen Modellnamen, z.B. íÉáäNIoder einen Modellnamen und einen Pfadspeicherort zuordnen,
z.B.=LéêçàNLîÉêëáçåPLíÉáäNK=Wenn Sie ein Modell nur mit einem Modellnamen bezeichnen,
muß sich die CADDS 5 Komponente in einem gültigen Suchpfad befinden. Wenn Sie ein Modell mit
einem Pfad und einem Modellnamen bezeichnen, muß sich die gesamte Verzeichnisstruktur in einem
gültigen Suchpfad befinden.

Angenommen, die Bezeichnung eines Komponentenmodells für einen CAMU (Concurrent Assembly
Mock-up)-Baugruppenknoten lautet LéêçàNLîÉêëáçåPLíÉáäN und die Pro/ENGINEER Sitzung ist
folgendermaßen eingerichtet:

� Die Umgebungsvariable CVPATH ist auf LÜçãÉLÄÉåìíòÉêNL~äíÉJíÉáäÉ gesetzt.

� Die Konfigurationsoption ÉñíÉåÇ|Åîé~íÜ ist auf LÜçãÉLÄÉåìíòÉêNLåÉìÉJíÉáäÉ=gesetzt.

In diesem Beispiel sind für das importierte qÉáäN CADDS 5 Modell die folgenden Speicherorte gültig:

� /proj1/version3/teil1

� LÜçãÉLÄÉåìíòÉêNL~äíÉJíÉáäÉLéêçàNLîÉêëáçåPLíÉáäN

� LÜçãÉLÄÉåìíòÉêNLåÉìÉJíÉáäÉLéêçàNLîÉêëáçåPLíÉáäN

Der eingebettete Pfad der Komponentenmodell-Definition muß an derselben Stelle wie der definierte
Suchpfad beginnen oder ein vollständiger Systempfad sein, z.B. /proj1/version3/teil1. Sie
finden beispielsweise íÉáäN=nicht in /home/benutzer1/alte-teile/teil1 oder in
LÜçãÉLÄÉåìíòÉêNLåÉìÉJíÉáäÉLíÉáäNK=Pro/ENGINEER sucht im definierten Suchpfad nach
LéêçàNLîÉêëáçåPLíÉáäN=und nicht nach=íÉáäN=allein. Wenn die Komponentenbezeichnung des
CAMU Knotens nur aus dem CADDS 5 Modellnamen EíÉáäN) besteht, sind sowohl
/home/benutzer1/alte-teile/teil1 als auch LÜçãÉLÄÉåìíòÉêNLåÉìÉJíÉáäÉLíÉáäN
gültige Pfade.

So überprüfen Sie den Status von importierten
Komponenten
1. Klicken Sie auf Datei > Associative Topology Bus > Status pruefen (File > Associative Topology

Bus > Check Status).
2. Folgendes geschieht:

� Die CADDS und CATIA Icons der veralteten Komponenten werden im Modellbaum jetzt rot
dargestellt.
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� Darüber hinaus wird im Pro/ENGINEER Mitteilungsfenster eine Meldung angezeigt, die darauf
hinweist, daß das Modell seit der letzten Speicherung in Pro/ENGINEER geändert wurde.

� Das System generiert eine Protokolldatei (íçéç|ÄìëKäçÖ) und speichert sie im
Arbeitsverzeichnis. Jedesmal, wenn Sie auf Datei > Associative Topology Bus > Satus pruefen
(File > Associative Topology Bus > Check Status) klicken, wird die Protokolldatei
íçéç|ÄìëKäçÖ=mit einer neuen fortlaufenden Nummer gespeichert. Anhand dieser Nummer
können Sie den Status von importierten Komponenten zurückverfolgen.

� Ein Informationsfenster mit dem Inhalt der Protokolldatei íçéç|ÄìëKäçÖ wird geöffnet.

Hinweis: Das Informationsfenster wird nur dann geöffnet, wenn die Option Protokolldatei zeigen (Show
Log File) aktiviert ist. Wenn Sie das Kontrollkästchen Protokolldatei zeigen (Show Log File) nicht
aktivieren, wird die Datei íçéç|ÄìëKäçÖ nicht angezeigt, jedoch im Arbeitsverzeichnis erzeugt und
gespeichert.

Inhalt des Informationsfensters
Bei der manuellen Überprüfung mit dem Befehl Status pruefen (Check Status) wird die Protokolldatei
topo_bus.log erzeugt und im aktuellen Verzeichnis gespeichert. Wenn die Option Protokolldatei
zeigen (Show Log File) aktiviert ist, wird eine Protokolldatei erzeugt und deren Inhalt in einem
Informationsfenster angezeigt. Anhand dieser Informationen können Sie entscheiden, ob die importierten
Komponenten aktualisiert werden müssen.
Das Informationsfenster enthält die folgenden Angaben zu den einzelnen importierten Komponenten:

� Name des importierten Modells

� Quellsystem (CADDS 5 oder CATIA)

� Vollständiger Pfad

� Wert des Überarbeitungsstandes in Pro/ENGINEER und im Quellsystem

� Anzahl der Flächen für Teile und Anzahl der Komponenten für Baugruppen in Pro/ENGINEER und in
den Quellsystemen

Die Anzahl der Flächen und Komponenten kann als Indikator für den Umfang der Änderungen
herangezogen werden. Wenn sich die Anzahl nicht geändert hat, lag möglicherweise lediglich eine
parametrische Änderung der Geometrie in einem Teil bzw. die Neuorientierung einer Komponente in einer
Baugruppe vor.

So überprüfen Sie automatisch den Status von
importierten Komponenten
Wenn die Option Status autom pruefen (AutoCheck Status) aktiv ist (Standard), wird automatisch
überprüft, ob die externen Referenzen veraltet sind.
1. Wählen Sie Datei > Associative Topology Bus (File > Associative Topology Bus).
2. Aktivieren Sie das Kontrollkästchen Status autom pruefen (AutoCheck Status).
3. Rufen Sie ein TIM (Translated Image Model) oder eine Pro/ENGINEER Baugruppe mit TIMs neu auf

bzw. aktivieren Sie diese Objekte. Anschließend wird automatisch die Versionsnummer der
importierten CADDS 5 oder CATIA Objekte überprüft. Die CADDS oder CATIA Icons für veraltete
importierte Objekte werden jetzt rot dargestellt, und im Pro/ENGINEER Mitteilungsfenster werden die
entsprechenden Meldungen angezeigt.

Die Anzahl der Komponenten und Flächen wird bei der automatischen Überprüfung nicht verglichen. Mit
dieser Option wird keine Protokolldatei generiert.

So aktualisieren Sie veraltete importierte
Komponenten
1. Wählen Sie Datei > Associative Topology Bus (File > Associative Topology Bus).
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2. Mit dem Befehl Alle aktualisieren (Update All) können Sie alle veralteten Teile aktualisieren. Mit
dem Befehl Aktualisieren (Update) können Sie einzelne Teilekomponenten auswählen, die Sie
aktualisieren möchten.

Die Baugruppe wird regeneriert, und die als veraltet gekennzeichneten Komponenten werden neu
importiert.
Hinweis: Sie können keine komplette Baugruppe aktualisieren.  Sie müssen die einzelnen Teile auswählen
und aktualisieren.

Hinweise zum Aktualisieren von importierten
Komponenten
Wenn das System veraltete importierte Teile- und Baugruppenkomponenten entdeckt, können Sie diese
aktualisieren, um die Änderungen im ursprünglichen Modell widerzuspiegeln. Diese Änderungen umfassen
Modifikationen der Geometrie, Komponentenplazierung und Foliendefinitionen.

Beachten Sie beim Aktualisieren von importierten Teilen und Baugruppen die folgenden Hinweise:

� Wenn Sie das Modell mit Regenerieren (Regenerate) regenerieren, werden veraltete importierte
CADDS 5 oder CATIA Teile und Baugruppen nicht aktualisiert.

� Wenn Sie eine selektive oder globale Aktualisierung durchführen, werden nur die als veraltet
gekennzeichneten Objekte neu importiert. Da Objekte auch dann veralten können, während sie in der
Sitzung aktiv sind, sollten Sie eine manuelle Überprüfung durchführen, bevor Sie eine globale oder
selektive Aktualisierung starten.





Associative Topology Bus 19

Index
A

Alle aktualisieren (Update All)................... 16
Associative Topology Bus............... 9, 10, 11
mit Baugruppen arbeiten....................... 10
mit Pro/CABLING arbeiten .................... 10
mit Teilen arbeiten................................. 10
Überblick ................................................. 9

ATB............................................................. 9

C

CADDS 5 ...................................... 12, 13, 14
Associative Topology Bus - Überblick... 12
mit Associative Topology Bus arbeiten . 13

CATIA ....................................................... 12
Associative Topology Bus - Überblick... 12

CATIA II .................................................... 13
direkte Übertragung .............................. 13

CDRS ................................................. 7, 8, 9
Associative Topology Bus - Überblick..... 7
importieren .............................................. 7
in Pro/ENGINEER aktualisieren.............. 8
zu einem Pro/ENGINEER Modell
hinzufügen........................................... 7

I

ICEM................................................... 7, 8, 9

Associative Topology Bus - Überblick ..... 7
importieren .............................................. 7
in Pro/ENGINEER aktualisieren .............. 8
zu einem Pro/ENGINEER Modell
hinzufügen ........................................... 7

P

Pro/DESKTOP .................................... 7, 8, 9
Associative Topology Bus - Überblick ..... 7
importieren .............................................. 7
in Pro/ENGINEER aktualisieren .............. 8
zu einem Pro/ENGINEER Modell
hinzufügen ........................................... 7

Protokolldatei zeigen (Show Log File) ...... 15

S

Status autom. pruefen (AutoCheck Status)
.............................................................. 16

T

TIM.............................................................. 9
Translated Image Model ............................. 9

U

Umgebungsvariable CVPATH .................. 14




